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1. ЦЕЛЬ И ЗАДАЧИ РАБОТЫ 

Цель работы – получение теоретических знаний и практических 

навыков в области разработки объемных кинематических моделей 

многоосевого оборудования с числовым программным управлением, 

проверки и отладки объемных кинематических моделей и их исполь-

зования для виртуальной отладки управляющих программ и постпро-

цессоров. 

Задачи: 

– ознакомиться с основами разработки объемной кинематической 

многоосевого станка; 

– создать кинематическую модель станка; 

– провести проверку работоспособности модели станка; 

– провести отладку УП с помощью созданной кинематической мо-

дели. 

2. ПОСЛЕДОВАТЕЛЬНОСТЬ ВЫПОЛНЕНИЯ РАБОТЫ 

1. Изучить методические указания по выполнению данной работы. 

2. Изучить подходы и последовательность разработки объемной 

кинематической многоосевого станка. 

3. Создать кинематическую модель станка по заданию преподава-

теля. 

4. Провести проверку работоспособности созданной кинематиче-

ской модели станка. 

5. Провести отладку УП с помощью созданной кинематической 

модели по заданию преподавателя. 

6. Оформить отчет по работе. 
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3. СОЗДАНИЕ ОБЪЕМНОЙ КИНЕМАТИЧЕСКОЙ МОДЕЛИ 

МНОГООСЕВОГО ОБОРУДОВАНИЯ С ЧПУ 

3.1. НАЗНАЧЕНИЕ ОБЪЕМНОЙ КИНЕМАТИЧЕСКОЙ 

МОДЕЛИ 

Объемная кинематическая модель многоосевого оборудования с 

ЧПУ, предназначенная для использования инженерами-технологами 

при технологической подготовке производства, необходима для от-

ладки управляющих программ (УП) и постпроцессоров. Также модель 

может использоваться при разработке автоматизированного участка, 

оснащенного манипуляторами для установки и снятия заготовки со 

станка, или для проектирования схема расположения оборудования на 

участках механических цехов. 

Использование модели для технологической подготовки про-

граммных операций позволяет проводить отладку, корректировку, ра-

ционализацию УП, спроектированных и выбранных приспособлений и 

инструмента при использовании сложного оборудования с ЧПУ, 

например, пятикоординатных фрезерных, токарно-фрезерных, много-

осевых обрабатывающих центров, имеющих несколько шпинделей 

или несколько суппортов с инструментом. 

Под отладкой УП следует понимать процесс проверки правильно-

сти разработанной УП на предмет отсутствия столкновений между 

рабочими органами станка, инструментом, заготовкой, правильности 

траекторий движения инструмента, включения вспомогательных 

функций, отсутствия зарезов, недорезов, а также процесс исправления 

УП. Отладка может производить как на станке, на котором будет про-

изводиться обработка партии деталей, так и с использованием объем-

ных кинематических моделей (так же называемых виртуальными мо-

делями). При отладке на станке может производиться обработка пер-

вой детали при постоянном контроле со стороны оператора станка и 

постоянном воздействии на скорость подачи рабочих органов станка. 

Либо отладка на станке может производиться с движениями инстру-

мента «по воздуху», т.е. с установленным инструментом, но без дета-

ли. 

Применение объемных кинематических моделей позволяет повы-

сить производительность технологической подготовки производства, 

сократить время непроизводительной работы многоосевого оборудо-
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вания с ЧПУ, связанного с ошибками в УП, сократить время внедре-

ния операций на сложное оборудование. Также значительно снижается 

риск поломки инструмента, приспособлений и частей станка из-за 

возможных соударений, вызванных ошибками в УП или в технологи-

ческой наладке на операцию. 

Программная среда для создания объемных кинематических моде-

лей и отладки УП с их помощью как правило доступна в САМ-

системах, позволяющих разрабатывать траектории движения режущих 

инструментов для операций механической обработки. В данной лабо-

раторной работе рассмотрена последовательность создания модели с 

использованием программного продукта Vericut.  

Программное обеспечение Vericut позволяет выполнять следую-

щие действия для рационализации технологической операции: 

̶ устранять столкновения рабочих органов станка между собой 

(например, шпинделя фрезерного станка с наклонно-поворотным сто-

лом), с приспособлением или с заготовкой; 

̶ исключать зарезы (места, где снят излишний слой материала с 

заготовки), недорезы (места на заготовке, где после работы по УП 

остается припуск, который должен был быть удален) и срезание мате-

риала с приспособления при работе по УП; 

̶ подбирать инструмент и инструментальную оснастку с нужны-

ми геометрическими параметрами, например, исключающими трение 

не режущих частей инструмента или инструментальной оснастки об 

обработанную часть заготовки; 

̶ уменьшать вылет режущего инструмента из оправки до 

наименьшего, но достаточного значения, повышая жесткость техноло-

гической системы; 

̶ рационализировать траекторию движения режущего и мери-

тельного инструмента, сокращая машинное время; 

̶ рационализировать минутную подачу режущего инструмента 

при изменении величины снимаемого припуска с заготовки во время 

сложнопрофильной обработки. 

3.2. РАЗРАБОТКА УПРОЩЕННОЙ ОБЪЕМНОЙ МОДЕЛИ 

СТАНКА 

Под упрощенной объемной моделью оборудования подразумевает-

ся сборочная модель, состоящая из отдельных деталей, а не тел, и опи-
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сывающая необходимые рабочие органы и узлы станка. Каждому ра-

бочему органу (узлу) станка может соответствовать одна или несколь-

ко деталей в сборке. Упрощенная модель строится в выбранной CAD-

системе и может быть передана в другую систему геометрического 

моделирования, например, с помощью форматов *.stp, *.x_t. В Vericut 

модели передаются в формате *.stl. 

3.2.1. ПОДХОДЫ К РАЗРАБОТКЕ УПРОЩЕННОЙ ОБЪЕМНОЙ 

МОДЕЛИ СТАНКА 

При создании упрощенной модели необходимо иметь доступ к 

действительному станку и его системе ЧПУ для осуществления про-

стых перемещений рабочих органов станка, определения размеров де-

талей станка. Под действительным станком понимается существую-

щий, установленный на предприятии, находящийся в работоспособ-

ном состоянии станок. 

Действительный станок состоит из узлов, которые состоят из мно-

жества различных деталей. При создании упрощенной модели нет 

необходимости моделировать все это множество. Достаточно создать 

одну модель детали для рабочего органа станка, которая характеризо-

вала бы наружный контур этого органа. В некоторых случаях для ра-

бочего органа может создаваться несколько моделей деталей, в соче-

тании образующих сам рабочий орган станка. Это происходит в слу-

чае, если упрощается процесс построения модели или повышается 

производительность работы кинематической модели. На рис. 1 пока-

зана модель наклонного устройства стола фрезерного станка, состоя-

щего из одной модели (рис. 1, а) и трех деталей (рис. 1, б). На рис. 1, а 

показан габаритный параллелепипед, размеры сторон которого соот-

ветствуют габаритным размерам детали. На рис. 1. б показаны три га-

баритных параллелепипеда для трех деталей. При моделировании 

процесса работы станка по УП программное обеспечение начинает 

отслеживать возможность столкновения, когда габаритный параллеле-

пипед инструмента пересекается с габаритным параллелепипедом 

наклонного устройства. Таким образом для модели, показанной на 

рис. 1, а, отслеживание столкновений начнется ранее в области где 

столкновения деталей маловероятны (в области между двумя верти-

кальными стойками). Для модели на рис. 1, б отслеживание начнется 

позднее, что приведет к более производительной работе программного 
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обеспечения до момента пересечения параллелепипедов по сравнению 

с моделью на рис.1, а. При этом точность отслеживания столкновений 

не понижается. 

 

 
а 

 
б 

Рис. 1. Модель наклонного устройства стола фрезерного станка 
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Степень точности создания моделей частей станка зависит от по-

ставленной задачи. Например, ограждение рабочей зоны станка может 

быть смоделировано, но в кинематической модели его присутствие 

необязательно, т.к. столкновения с ним маловероятны, но при этом он 

закрывает обзор. В других программных продуктах по моделированию 

производственных процессов загрузка ограждение рабочей зоны стан-

ка будет необходима. Точность соответствия размеров ограждения 

действительного станка размерам модели может быть невысокой, по-

лученной при измерении с помощью линейки или рулетки. 

Для создания точной модели требуется знать размеры частей стан-

ка и их относительное положение. Некоторые размеры приводятся в 

технической документации, поставляемой со станком. К ним относят-

ся размеры между поворотными осями станка и нулевой точкой стан-

ка, предельные перемещения рабочих органов станка, координаты 

точки смены инструмента и др. Например, для фрезерного станка с 

наклонно-поворотным столом указывается расстояние между осью 

наклона стола (координата А) и продольной осью перемещения (коор-

дината Х), берущей начало в нулевой точке станка. 

Большая часть размеров может быть получена путем непосред-

ственного измерения на станке с применением штангенциркуля, ли-

нейки или рулетки. С максимально возможной точностью необходимо 

измерять те части, которые наиболее вероятно могут столкнуться 

между собой в процессе работы станка, например, шпиндель, оси Z, A, 

C фрезерного станка с наклонно-поворотным столом. 

При измерении конструктивных элементов в рабочей зоне станка с 

помощью линейки или рулетки размеры модели необходимо задавать 

таким образом, чтобы это приводило к увеличению толщины модели 

на 1-5 мм по сравнению с действительным станком (увеличивая раз-

меры для валов и уменьшая для отверстий). При этом на кинематиче-

ской модели станка при отладке УП может произойти столкновение 

рабочих органов, тогда как на действительном станке столкновения бы 

не произошло. При этом потребуется, например, увеличить вылет ин-

струмента и это будет предпочтительным вариантом по сравнению со 

столкновением на действительном станке из-за модели, построенной с 

уменьшением толщины конструктивного элемента. 

Части столкновение с которыми других частей невозможно, заме-

ряются менее точно с помощью линейки или рулетки. 
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Построение моделей деталей предпочтительно осуществлять в си-

стеме координат станка, начало которой совпадает с нулевой точкой 

станка. В этом случае создание кинематической модели будет проис-

ходить быстрее и удобнее, без дополнительных перемещений моделей 

друг относительно друга. 

3.2.2. ПРИМЕР УПРОЩЕННОЙ ОБЪЕМНОЙ МОДЕЛИ 

СТАНКА 

Рассмотрим особенности создания упрощенной объемной модели 

на примере пятикоординатного фрезерного обрабатывающего центра 

Mikron UCP 800 Duro. 

Кинематическая схема данного пятикоординатного станка постро-

ена по схеме станка с наклонно-поворотным столом. 

К станине станка крепятся стойки, в которых находятся электро-

двигатели для управления наклонным устройством (координата А, ко-

торая вращается вокруг оси X). Непосредственно на оси А располага-

ется стол для установки приспособлений и заготовки – ось С, враща-

ющаяся вокруг оси Z. Нулевая точка станка располагается на пересе-

чении поверхности стола с осью его вращения. Ось вращения также 

совпадает с осью центрального посадочного отверстия ø32H7. 

На станине также расположены направляющие линейной оси Х. По 

оси X перемещается ось Y, а по оси Y – ось Z. В оси Z расположен 

шпиндель станка, в который устанавливается инструмент. Хвостовик 

инструментальных оправок HSK A 63. Нулевая точка нулевого ин-

струмента (т.е. без инструмента в шпинделе) находится на пересече-

нии торца шпинделя с осью его вращения. 

На рис. 2 показано рабочее пространство станка в плоскости YZ 

системы координат станка. 
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Рис. 2. Рабочее пространство станка в плоскости YZ 

 

Модель станка, созданная в CAD-системе, состоит из девяти 

укрупненных частей: оси X, Y, Z, A (наклонное устройство), C (рабо-

чий стол), шпиндель, станина, стойки, кожух (ограждение рабочей зо-

ны). При построении модели оси X, Y, Z должны располагаться таким 

образом, чтобы нулевая точка станка совпадала с нулевой точкой ин-

струмента. Таким образом следует строить модель, даже если действи-

тельный станок не может переместить все оси в такое положение. Это 

достигается, когда каждая деталь создается в системе координат стан-

ка. Оси С и А также построены в нулевом положении. Модель станка, 

созданная в CAD-системе, показана на рис. 3. 
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Рис. 3. Модель станка, созданная в CAD-системе 

 

На станке Mikron UCP 800 Duro можно переместить в такое поло-

жение оси X и Y, а ось Z нет, т.е. торец шпинделя будет отстоять от 

плоскости стола минимум на 100 мм. 

Далее данная модель может использоваться для создания кинема-

тической модели станка. 

3.3. РАЗРАБОТКА ОБЪЕМНОЙ КИНЕМАТИЧЕСКОЙ МОДЕЛИ 

МНОГООСЕВОГО ОБОРУДОВАНИЯ С ЧПУ 

С ПРИМЕНЕНИЕМ СИСТЕМЫ VERICUT 

Переходим к созданию объемной кинематической модели станка. 

Процесс также рассмотрим на примере пятикоординатного фрезерного 

обрабатывающего центра Mikron UCP 800 Duro. Запускаем программу 

Vericut. По умолчанию при загрузке программ открывается проект-

образец. Создаем новый проект. 

Menu > File > New Project > Millimeter. 
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Окно программы состоит из дерева проекта (расположено слева), 

панели инструментов (расположена в верхней части), графической ча-

сти (расположена в средней части) и информационной панели (распо-

ложена в нижней части). На рис. 4 показан вид дерева проекта после 

создания нового проекта. Фиолетовым цветом показаны не определен-

ные элементы проекта. При определении (выборе файла или задании 

значения) элемента он окрашивается черным цветом. 

 

 
Рис. 4. Дерево нового проекта 

 

Для удобства пользователя в программе Vericut существует воз-

можность настроить управление мышью как в других CAD/CAM-

системах. Настраиваем управление, например, как в системе CATIA 

V5. 

Menu > View > Dynamic Controls > CATIA. 

Настраиваем вид графической области. В ней может располагаться 

от 1 до 4 отдельных видов (заготовка и инструмент со станком или 

зона резания отдельно). Выбираем один вид. 

Menu > View > Layout > Standard > 1. 

Настроим вид со станком. Для этого необходимо нажать правой 

кнопкой мыши в графической области и далее выбрать вид. 

View type > Machine. 
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Создадим модель станка в системе Vericut. Ось X должна нахо-

диться на станине. В дереве проекта находится элемент Machine. По 

умолчанию у него есть дочерний элемент Base (станина). Добавляем к 

станине линейную ось Х. 

Base > Нажать правой кнопкой мыши > Append > X Linear. 

Таким же образом добавляем к части X Linear часть Y Linear, а за-

тем к части Y Linear часть Z Linear. Шпиндель станка размещаем на 

оси Z. 

Z Linear > Нажать правой кнопкой мыши > Append > Spindle. 

Подобно к части Spindle добавляем часть Tool.  

Ось A (наклонная ось) также должна находиться на станине. 

Base > Нажать правой кнопкой мыши > Append > A Rotary. 

К части A Rotary добавляем часть C Rotary, т.е. вращающийся 

стол. Приспособление и заготовка устанавливаются на стол станка, т.е. 

на ось С. В дереве проекта эти элементы созданы по умолчанию. Их 

можно перетащить мышью в ось C, т.е. в дереве они должны стать до-

черними элементами оси С. Если этого действие не дает результата, то 

можно удалить часть Attach. Вместе с ней удалятся приспособление и 

заготовка. После этого с помощью команды Append можно добавить 

Attach к оси С, а затем к части Attach добавить Fixture (приспособле-

ние) и Stock (заготовка). 

Фиолетовый цвет означает, что элемент не определен. Не опреде-

лены приспособление и заготовка. После добавления их моделей эти 

элементы в дереве будут отображаться черным цветом. В новом про-

екте все элементы отображаются фиолетовым цветом. 

Таким образом, создана кинематическая схема станка, а не сам 

виртуальный станок. Следующим шагом является добавление моделей 

составных частей станка в проект. Модели можно добавлять либо по-

сле создания кинематической схемы станка, либо после добавления 

каждой из частей станка. В итоге это даст одинаковый результат. 

Добавим модель станины. 

Base > Нажать правой кнопкой мыши > Add Model > Model File. 

Далее указываем путь к файлу станины. Удобнее всего в систему 

Vericut загружать файлы с расширением STL. Также можно создать 

параллелепипед, цилиндр, конус, тело вращения или выдавливания, 

если выбрать соответствующий пункт вместо Model File. 

В разделе Configure Model выбираем вкладку Model. На этой 

вкладке есть возможность задать цвет части станка. Для разных частей 
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желательно выбрать разные цвета для больше удобства в использова-

нии. Красный цвет не рекомендуется использовать, потому что он 

применяется системой для обозначения ошибок (зарезов, столкнове-

ний). Добавляем все созданные модели соответствующим частям 

станка и изменяем их цвета. 

Станина, например, состоит из четырех составных частей, ось Z из 

трех. После создания кинематической схемы данного станка и добав-

ления моделей дерево проекта и графическая область будут выглядеть 

так, как показано на рис. 5. Оси станка находятся в нулевом положе-

нии, так как и в модели, созданной в CAD-системе. 

Сохраняем файл с созданным станком. Далее его можно будет от-

крывать в других проектах, а не создавать заново. 

Configuration > Machine > Save. 

 

   
а     б 

Рис. 5. Дерево модели со структурой станка (а) и кинематическая модель станка (б) 

3.4. ПРОВЕРКА МОДЕЛИ 

Следующим шагом идет проверка работоспособности станка. Это 

необходимо сделать до начала его использования для отработки 

управляющих программ. Осуществить это можно с помощью меню 

ручного ввода данных или режима MDI. Меню режима ручного ввода 
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данных показано на рис. 6. Выбираем нужную ось (Axis) из выпадаю-

щего списка и с помощью клавиш « + » и « – » можно перемещать ось 

и все части, связанные с ней, вдоль выбранной оси в положительном и 

отрицательном направлении соответственно. Параметр Jog Distance 

позволяет настроить количество миллиметров (для линейных осей) 

или градусов (для вращающихся осей), на которое будет перемещаться 

ось станка при одном нажатии на клавиши « + » и « – ». 

 

 
Рис. 6. Режим MDI 
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Попробуем переместить на разные значения и в разные стороны 

линейные оси станка для проверки работоспособности. Далее отведем 

оси Х, Y и Z, для того, чтобы переместить оси А и С. Повернем ось А 

в положительном направлении на 70 градусов. Вращение выполняется 

с ошибкой, которая показана на рис. 7, б. Система Vericut считает, что 

наклонное устройство (ось А) должно вращаться вокруг оси Х нулевой 

системы координат станка. У реального станка ось вращения по коор-

динате А отстоит от оси Х на 120 мм по направлению Z и на 50 мм по 

направлению Y. 

 

  
а     б 

Рис. 7. Положение оси А до поворота (а) и положение оси А после поворота (б) 

 

Для исправления ошибки с осью вращения наклонного устройства 

необходимо выбрать ось А в дереве проекта. В меню редактирования 

параметров оси А (рис. 5, а) выбрать вкладку Translate, на этой вкладке 

в параметре Position поставить значения «0 -50 120». При этом 

наклонное устройство переместиться вверх на 120 мм (в положитель-

ном направлении оси Z) и на 50 мм ближе к оператору (в отрицатель-

ном направлении оси Y) (рис. 8, а). Данные размеры определены по 

рис. 2. 

Для устранения этой ошибки нужно выбрать модель оси А, кото-

рая обозначена как STL. В меню редактирования параметров модели 
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выбрать вкладку Translate, на этой вкладке в параметре Position поста-

вить значения «0 50 -120». После этого наклонное устройство отобра-

жается верно, но неверно отображается стол станка. Необходимо из-

менить положение стола станка (ось С) на такие же значения 

«0 50 -120». 

 

 
а 

 
б 

Рис. 8. Положение оси А после переноса элемента (а) и положение оси А и оси С по-

сле переноса моделей оси А (б) 
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После этих действий проводится проверка работоспособности 

станка при перемещении координаты А. 

Необходимо задать следующие параметры для определения поло-

жения станка: начальное положение и положение при смене инстру-

мента. 

Configuration > Machine Settings > Locations > Machine Locations > 

Location Name > Initial Machine Location > Add. 

В параметр Values (XYZABCUVWABC) записываем значения 

«0 330 600». Нажимаем кнопку Apply.  

 

 
Рис. 9. Положение осей станка в исходном положении 

 

По такой же схеме добавляем Tool Change Location и задаем для 

этого параметра значения «0 330 550». Нажимаем кнопку Apply, затем 

OK. Нажимаем кнопку Reset Model и станок перемещается в свое ис-

ходное положение. 
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4. НАСТРОЙКА ОБРАБОТКИ С ИСПОЛЬЗОВАНИЕМ 

ОБЪЕМНОЙ КИНЕМАТИЧЕСКОЙ МОДЕЛИ 

Рассмотрим технологию проверки управляющей программы, её 

последующую доработку и корректировку технологических парамет-

ров с целью рационализации программной операции с применением 

программного обеспечения Vericut. В качестве примера выберем пяти-

координатный фрезерный обрабатывающий центр Mikron UCP 800 

Duro. 

Для настройки обработки необходимо обязательно задать УЧПУ, 

Станок, Оснастку, Программы ЧПУ (рис. 4). Остальные ветви дерева 

могут задаваться при необходимости, например, система координат 

детали и нулевая точка детали, задаваемая с помощью команды G54 

при программировании в G-кодах. 

Выбираем систему управления станком. 

Control > Нажать правой кнопкой мыши > Open > Shortcut > 

Library. 

Выбираем файл hei530.ctl, который имитирует стойку ЧПУ Hein-

denhain iTNC530, установленную на обрабатывающем центре Mikron 

UCP 800 Duro. 

Добавляем приспособление на стол станка. Модель приспособле-

ния создана в системе координат станка, поэтому при загрузке распо-

лагается верно относительно станка. 

Fixture > Нажать правой кнопкой мыши > Add Model > Model File. 

Добавляем заготовку. 

Stock > Нажать правой кнопкой мыши > Add Model > Model File. 

Заготовка устанавливается в неверное расположение, она совпала с 

приспособлением. Для исправления положения необходимо задать в 

параметре Position значения «0 0 147». Первое число показывает на 

смещение заготовки относительно нулевой точки станка вдоль оси X, 

второе – вдоль оси Y, третье – вдоль оси Z. Расположение заготовки 

изменится (рис. 10). 
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Рис. 10. Положение заготовки в приспособлении 

 

Обозначим программный ноль. Он должен располагаться в следу-

ющих координатах станка «0 0 147». 

Setup 1 > Нажать правой кнопкой мыши > G-Code > Settings > Ta-

bles > Add/Modify > Table Name > Program Zero > Add. 

Далее необходимо задать инструменты, которые участвуют в обра-

ботке. Данные об инструменте сохраняются в отдельном файле с рас-

ширением *.tls. Если такой файл уже создан, то можно открыть его в 

проекте. 

Tooling > Нажать правой кнопкой мыши > Open. 

Если файл с набором инструмента не создан, то можно создать но-

вый набор. 

Tooling > Нажать правой кнопкой мыши > Tool Manager… 

Открывается окно управления инструментом. Создадим новый 

фрезерный инструмент. 

Add > Tool > New > Mill. 

Открывается окно, в котором задаются параметры режущего ин-

струмента и инструментальной оснастки. Переименовываем инстру-

менты в 1, 6 и 28, т.к. по управляющей программе данные инструмен-
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ты указаны под номерами 1, 6, 28, т.е. на станке они устанавливаются 

в соответствующие позиции инструментального магазина. 

Далее создаем оправку. Для этого в выпадающем списке 

Component Type выбираем Holder. 

После создания инструмент отображается в окне управления (рис. 

11). На рис. 11 показана точка, которая находится на торце цилиндри-

ческой фрезы. Эта точка двигается по координатам из управляющей 

программы. Эта же точка будет привязана к нулевой точке шпинделя. 

Т.е. при обработке на виде со станком инструмент отображаться не 

будет, т.к. фактически он будет находится внутри шпинделя. Для 

устранения этой ошибки необходимо задать точку привязки к шпин-

делю, которая должна располагаться на торце оправки, т.е. надо знать 

вылет инструмента из шпинделя станка. 

 

 
Рис. 11. Вид созданного инструмента 

 

Добавим управляющую программу в проект. Система ЧПУ 

Heindenhain открывает файлы с расширением «*.h». 

NC Programs > Add NC Program Files. 

Можно выбрать несколько управляющих программ, например, ес-

ли с помощью постпроцессора были получены отдельные программы 
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для каждого инструмента. Загружаем программы UP1-ROUGH.h, 

UP2-5X_PRODUCTION.h и UP3-5X_PRODUCTION2.h. 

После задания необходимых объектов дерево проекта выглядит, 

как показано на рис. 12. 

 

 
Рис. 12. Вид дерева проекта после задания необходимых объектов 

 

После выполнения этих действий можно запускать виртуальную 

обработку. 

На рис. 13 показана обработка первым инструментом.  
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Рис. 13. Обработка первым инструментом 

 

 
Рис. 14. Области ошибок, выделенные красным 
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На рис. 14 видны области, выделенные красным цветом и обозна-

чающие ошибки. Обработка происходит с ошибками. Первая область 

(большая красная зона справа сверху) возникает из-за столкновения 

заготовки с инструментальной оправкой. Для устранения этой ошибки 

нужно увеличить вылет инструмента из оправки. Вторая область появ-

ляется из-за касания хвостовиком фрезы обработанной поверхности 

заготовки. Для устранения ошибки можно выбрать фрезу с большей 

длиной шейки (занижения диаметра). 

Можно рассчитать вылет инструмента автоматически. 

Setup:1 > Motion > Calculate Min. Cutter Extension 

Задаем Holder Clearance равным, например, 5 мм. Запускаем обра-

ботку заново. В окне сообщений появится надпись «Tool's first holder 

height has been adjusted by 38». 

При наличии ошибок в программе происходит выделение их крас-

ным цветом. При последующей обработке эти ошибки могут быть 

удалены со снимаемым металлом. Для того, чтобы не пропустить 

ошибки можно настроить остановку при их возникновении. 

Project > Start/Stop > Stop at max errors. 

Остановку также можно настроить при смене инструмента. 

Точные данные об ошибках можно посмотреть следующим обра-

зом: 

Info > Vericut log. 

Полную сводку о проекте можно посмотреть следующим образом: 

Info / Status. 

На рис. 20 показана деталь, полученная после отработанной опера-

ции обработки. 
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Рис. 15. Обработанная заготовка 

 

Время проверки управляющей программы зависит от производи-

тельности ПЭВМ. Производительность можно повысить, если скрыть 

все оси и нулевые точки. Также можно производить проверку без 

движения (Motion no animation) или пропускать кадры управляющей 

программы (skip cut). 

Можно включить режим поддержки аппаратного ускорения Open 

GL. 

Правой кнопкой в графической области > Accelerated (Open GL). 

В результате была отработана управляющая программа для пози-

ционной пятикоординатной обработки. По рассмотренной методике 

можно создавать трех и четырехкоординатное оборудование, отраба-

тывать программы пятикоординатной непрерывной обработки. 

5. ПРОВЕРКА ОБЪЕМНОЙ КИНЕМАТИЧЕСКОЙ МОДЕЛИ 

НА ОТРАБОТАННОЙ ДЕТАЛИ 

После создания объемной кинематической модели необходимо 

произвести проверку на соответствие действительному станку. Эта 

проверка может быть проведена с помощью тестовой программы, в 

которой описаны кадры с перемещением рабочих органов в такие ко-
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ординаты, в которых разные рабочие органы отстоят друг от друга на 

небольшом расстоянии. Это расстояние необходимо измерить и срав-

нить с расстоянием на действительном станке. Также проверка модели 

может быть с помощью процесса моделирования изготовления отра-

ботанной детали, т.е. уже изготовленной на станке. 

Оба способа могут оставить невыявленными некоторые ошибки 

построения упрощенной объемной модели станка. В связи с этим об-

работку первых деталей партий вначале необходимо проводить с 

осторожностью. 

6. ИСПОЛЬЗОВАНИЕ ОБЪЕМНОЙ КИНЕМАТИЧЕСКОЙ 

МОДЕЛИ ДЛЯ ВИРТУАЛЬНОЙ ОТЛАДКИ 

ПОСТПРОЦЕССОРОВ 

Постпроцессор – программа, формирующая кадр УП для станка с 

ЧПУ на основании данных, передаваемых из САМ-системы. Постпро-

цессор учитывает особенности определенного станка и САМ-системы. 

Разработанная кинематическая модель может использоваться для 

отладки нового постпроцессора для станка. Для этого необходимо 

сначала произвести отладку с помощью управляющих программ, со-

держащих простые перемещения, например, обработка тестовых кон-

структивных элементов деталей в наклонных осях, обработка с ис-

пользованием простых циклов обработки, например, сверления. Далее 

отладка может производиться с использованием УП, получаемых с 

новым постпроцессором для деталей, которые уже изготавливались на 

станке. 

7. СОДЕРЖАНИЕ ОТЧЕТА 

В процессе выполнения работы оформляется отчет. В отчете при-

водятся: схема обработки заготовки с указанием нулевых точек; вид 

дерева станка и дерева операции после создания объемной кинемати-

ческой модели; общий вид кинематической модели станка; общий вид 

заготовки, полученной с помощью моделирования работы станка; от-

вет на индивидуальное задание и выводы по работе. 
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КОНТРОЛЬНЫЕ ВОПРОСЫ 

1. Для чего предназначена объемная кинематическая модель станка? 

2. Что означает отладка управляющей программы? 

3. Какие действия позволяет выполнять программное обеспечение для отладки 

УП? 

4. Что понимается под действительным станком? 

5. Для чего модель одного рабочего органа может разделяться на части? 

6. От чего зависит степень точности моделирования деталей? 

7. Какие координаты перемещения есть у станка с наклонно-поворотным столом? 

8. В какой системе координат строятся модели рабочих органов станка? Почему? 

9. Как осуществляется проверка кинематической модели станка? 

10. Какие объекты должны быть заданы в дереве построения для запуска процесса 

отладки УП? 

11. Как устраняются ошибки, выявленные при моделировании процесса работы 

станка? 

12. Что понимается под постпроцессором? 
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1. Определение схемы обработки заготовки с указанием нулевых точек 
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3. Общий вид кинематической модели станка 

 

 

 

 

 

 

4. Общий вид заготовки, полученной 

с помощью моделирования работы станка 

 

 

 

 

 

 

5. Индивидуальное задание 

 

 

 

 

 

 

6. Выводы по работе 
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